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Lesson 3 

Floor Plans 
 

 

The floor plan is central to any architectural drawing.  We start by placing the exterior 

walls, then the interior walls, then doors, and finally windows. 

 

 

Tool Palette Walls 

Command Line WallAdd 

Menu Design→Walls→Add Wall 

 

 

 
Exercise 3-1: 

Creating Exterior Walls 
 

Drawing Name: New 

Estimated Time: 10 minutes 

 

This exercise reinforces the following skills: 

  

� Create Walls 

� Project Navigator 

 

1.  Start a new drawing using QNEW. 

  

2.  Launch the Tool Palette. 

  

Select the Walls tab. 

 

 

 
 

Select the CMU-8 RIGID-1.5 

Air-2 Brick-4: wall style. 
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3. 

 
 

Toggle ORTHO ON. 

 

Start the wall at 0,0. 

Create a rectangle 60′ tall and 30′ wide. 

 

4. Select the Work tab. 
 

 

 

5. You see that the walls you placed are really 3-dimensional.   

 

6. Save your drawing as Ex3-1.dwg. 

 

 
TIP:  If you draw a wall and the materials composing the wall are on the wrong side, 

you can reverse the direction of the wall.  Simply select the wall, right click and select 

the Reverse option from the menu. 



Copyrighted 
Material 

 
Copyrighted 

Material 
 

Copyrighted 
Material 

 
Copyrighted 

Material 

Lesson 3 - Floor Plans 

3-3 

Exercise 3-2: 

Convert  to Walls 
 

Drawing Name: new 

Estimated Time: 60 minutes 

 

This exercise reinforces the following skills: 

 

� Convert to Walls 

� Drawing references (previously known as external references or Xrefs) 

� Creating Interior Walls 

 

1. 
 

 

Start a new drawing using QNEW. 

2. Go to Insert→External Reference. 

   

3. Locate ex3-1.dwg. 

Press Open. 

 

 

 

 

 
TIP:  Many architects use external drawing references to organize their projects.  That 

way teams of architects can concentrate just on their portions of a building.  External 

references also use less system resources. 
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4. 

 
 

 

 Uncheck Specify On-Screen under Insertion point, scale, and rotation. 

 

Press OK. 

This will insert the file as an external reference at 0,0,0. 

 

 

 

 

 

 
TIP:  You can convert lines, arcs, circles, or polylines to walls.  If you have created a 

floor plan in AutoCAD and want to convert it to 3D, open the floor plan drawing 

inside of AutoCAD Architecture.  Use the Convert to Walls tool to transform your 

floor plan into walls. 
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5. 

 
 

Create the layout shown using lines or 

polylines.   (It may be helpful to turn off the A-

Walls layer while you are working and create 

your lines on layer 0). 

 

Do not add the dimensions or the text to 

your drawing.  They are there to help you 

place the lines only. 

 

Don’t draw using rectangles if you are going to 

use the CONVERT method or you will get 

duplication of lines over lines, which will 

affect the wall creation. 

 

If you do not want to spend time creating the 

floor plan, you can download the drawing 

‘floor plan.dwg’ from www.schroff1.com. 

 

6. 

 
 

Locate the Stud-4 GWB-0.625 Each Side: 

wall style. 

7. Highlight the Wall tool. 

Right click and select Apply Tool Properties to→Linework. 
 

 

 
 

8. Select all the interior polylines you just created. 

 
 

 You are prompted if you want to erase the layout geometry.  Type Y for Yes. 

 

9. Switch to the Work tab so you can see how your house looks in 3D. 
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10. Save the file as ex3-2.dwg. 
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Exercise 3-3: 

Wall Cleanup  
 

Drawing Name: ex3-2.dwg 

Estimated Time: 30 minutes 

 

This exercise reinforces the following skills: 

 

� Modifying Walls 

� Edit Justification 

� Wall Tools 

� Xref Manager 

� Edit External References In-Place 

� Unreconciled Layers 

 

 

1.   Open ex3-2.dwg. 

 

2. 

 
 

Add a closet area between the master bedroom and 

Bedroom #1. 

 

To do this, draw a wall from the mid-point of the 

wall in the horizontal direction and then draw a 

vertical wall from the mid-point of the new 

horizontal wall. 

3. 

 
 

To center the vertical wall, select it. 

Right click and select Edit Justification. 

 

4. 

 

Diamond grips will appear to indicate different wall 

justification methods (Left/Right/Center). 

 

Select the Center Diamond. 
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5. 

 
 

Draw a closet in Bedroom #2. 

Use the same interior wall style. 

Set the wall 1′ from the hallway wall and 6′ in length. 

 

 
 

 

 

Draw a vertical line 2′ inside the living room area. 

 

 

Locate the exterior wall style we used previously. 

 

Convert the vertical line to the exterior wall styles using Apply 

Tool Properties to Linework. 
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6. 

 
 

Next, we delete the wall indicated and modify the 

exterior wall so it creates a porch entry way.. 

 

 

7. 

 
 

Select the exterior walls. 

Right click and select Edit Xref in-place. 

8. 

 
 

Enable Automatically 

select all nested objects. 

 

Press OK. 

 

By enabling the ability to 

select nested objects, you 

would be able to select 

blocks or other items 

inserted in the drawing.  It 

is not really applicable 

here as there are no nested 

objects…just walls. 

 

 You’ll notice that the interior walls now appear lighter to allow you to select the 

referenced file’s objects. 
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9. 

 
 

Use the Break tool to create the opening for the living room 

entrance. 

10. 

 
 

Locate the CMU-8 Rigid-1.5 Air-2 

Brick-4 wall style. 

11. 

 
 

Draw a new wall section indenting 4′ in 

using the end points of the remaining 

exterior wall. 

12. 

 

A circle with an ‘x’ will appear.  This indicates a fault error. 

A fault error occurs when walls over-lap or you have a wall 

in the wrong direction. 

 

In this case, the wall was drawn in a different direction (note 

the hatch pattern.) from the other walls. 
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13. 

 

 

If you select the wall, blue grips appear.  The blue arrow indicates 

the exterior side of the wall. 

14. 

 
 

If you select a different wall, you see that the blue arrow is 

located on the opposite side.   

 

All the walls should have the blue arrow located on the exterior 

side. 

 

To flip the wall, simply left pick on the blue arrow. 

15. 

 
 

The corners may require some clean-up work. 

16. Select a wall. 

Right click and select Apply ‘L’ 

Cleanup. 

Then select the adjacent wall. 

 

17. 
 

 

Select the Save and Close Xref tool. 

18. Press OK. 

 

You can now edit the interior walls but 

not the exterior walls. 
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19. 

 
 

The walls appear cleaner. 

  

 

 

 
 

If you have difficulty cleaning up the walls using the ‘Edit Xref in-

place’ option, select the external reference, right click and select 

‘Open Xref’. This will open up the file you are referencing.  Clean up 

the walls as needed, then save.  The drawing hosting the external 

reference will update. 

 

 

 

You may see a notification that you have unreconciled layers.  

Unreconciled layers are new layers that have been added to a drawing 

without user acknowledgement.  When you inserted the external reference 

file, new layers were added to the drawing. 

 

20. Select the layer alert icon in the task tray. 

 

21. 

 

You will see a category for 

Unreconciled New Layers and 

the right pane will display a 

list of the new layers. 

22. 

 

Highlight the layer in the right 

pane. 

 

Right click and select ‘Reconcile 

Layer’. 
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23. 

 
 

The layer will be added to the Used 

Layer list. 

 

Press Apply and OK to exit the 

Layer Manager dialog. 

24. The drawing is now updated. 

 

Save as ex3-3.dwg. 
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Exercise 3-4: 

Adding Closet Doors 
 

Drawing Name: Ex3-3.dwg 

Estimated Time: 10 minutes 

 

This exercise reinforces the following skills: 

 

� Adding Doors 

� Door Properties 

 

 

1.   Open ex3-3.dwg. 

 

2. 

 
 

Locate the Bifold-Double door on the Doors tab of the 

Tool Palette. 

3. 

 
 

Highlight the Bifold-Double door. 

Right click and select Properties. 

 

 

 
TIP:  To create a freestanding door, press the ENTER key when prompted to pick a 

wall.  You can then use the grips on the door entity to move and place the door 

wherever you like. 

 

To move a door along a wall, use Door→Reposition→Along Wall.  Use the OSNAP 

From option to locate a door a specific distance from an adjoining wall. 
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4. Expand the Dimensions section. 

Set the Standard sizes to  

5′-0″ x 6′-8″. 

 

 

 

 

 

 

 

 

 

 

 Set the Opening percentage to 50. 
 

A 25% opening will show a door swing at a 45-degree angle. 

The value of the Opening percentage determines the angle of the arc swing.   

A 50% value indicates the door will appear half-open at a 90-degree angle.   

 

5. 

 

 

Expand the Location section. 
 

Set Position along wall to Offset/Center. 
 

 

 Set the Automatic offset to 1′-2 1/2″.   
 

(This will center the closet doors along the wall.) 
 

Press OK to close the Properties dialog. 

 

 

 
TIP:  Note the vertical alignment field.  It defaults to a threshold height of 0″ for 

doors and a head height of 6′8″ for windows.  You will need to adjust these defaults in 

multi-story buildings. 

 
TIP:  If you left click in the field, a down arrow will appear…select the down arrow 

and you will get a list of standard sizes.  Then, select the size you want. 
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6. Place the Bifold Double doors at the two closets. 
 

The orientation of the door swing is determined by the wall side selected. 

In both cases, you want to select the outside face of the wall. 
 

 
 

7. 

 
 

Place a Bi-fold Double door in the wall shown. 

 

 

 

8. Save as ex3-4.dwg.  
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Exercise 3-5: 

Adding Interior Doors 
 

Drawing Name: ex3-4.dwg 

Estimated Time: 10 minutes 

 

This exercise reinforces the following skills: 

 

� Adding Doors 

� Door Properties 

 

 
 

We will add single hinge doors in the areas shown. 

 

You may need to do some wall cleanup to get the rooms to look proper. 

 

Use AddWall, Extend, and Trim as needed. 

 

Try to keep the walls so they line up to keep the floor plan looking clean. 

 

1.      Open ex3-4.dwg. 

 

2. 

 

Locate the Single Hinged door on the Doors tab of the Tool Palette. 

Right click and select Properties. 
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3. 

 

 

Expand the Dimensions section. 

Set the Standard sizes to  

2′-6″ x 8′-0″. 

Set the Swing angle to 25. 

4. 

 

Set the Position along wall to Offset/ Center. 

Set the Automatic offset to 6″. 
 

Press OK. 
 

 

5. Place the doors as indicated on the previous page. 

 

6. Save the file ex3-5.dwg. 
 

 

 

 

Exercise 3-6: 

Add Opening 
 

Drawing Name: ex3-5.dwg 

Estimated Time: 15 minutes 

 

This exercise reinforces the following skills: 

 

� Adding Openings 

� Opening Properties 

� Copying Tools 

� Set Image from Selection 

 

Openings can be any size and elevation.  They can be applied to a wall or be 

freestanding.  Openings are placed on Layer A-Wall-Open.  The Add Opening Properties 

allow the user to either select a Pre-defined shape for the opening or use a custom shape. 
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1. 

  

Open ex3-5.dwg. 

2. 

 
 

Locate the Opening on the Design tab of the 

Tool Palette. 

 

Copy a Tool 
 

3. 

 
 

Right click and select Copy. 

4. 

 
 

Select the Doors tab. 

Right click and select Paste. 

5. 

 
 

Highlight the copied tool. 

Right click and select Properties. 

6. 

 
 

Change the Name to Arched Opening. 

Change the Description to Creates an arched 

opening object. 

 Expand the General section. 

Set the Description to Creates an Arched 

Opening. 

Set the Layer key to OPENING. 

Set the Shape to Arch. 
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Expand the Dimensions section. 

Set the Width to 3′-0″. 

Set the Height to 6′-8″. 

Set the Rise to 1′-0″. 

 

 

 

Press OK. 

 

Expand the Location section. 

Set the Position along wall to Offset/Center. 

Set the Automatic offset to 3′-4″. 

7. 

 
 

Place the arched opening in the dining room 

wall. 

8. Use View→3D orbit to view the arched opening. 

 
Create an Image for a Tool 
 

9. 

 

Select the Arched Opening icon. 

Right click and select Set Image from Selection… 

Pick the arched opening you created. 

The icon updates to show an arched opening.    

 

 

 

 

Next we place a rectangular opening in the location 

indicated. 
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10. 

 
 

Select the Cased Opening tool from the Doors Tool Palette. 

11. 

 
 

Expand the Dimensions section. 

Set the Width to 6′-0″. 

Set the Height to 6′-8″. 

 

 

 
 

Expand the Location section. 

Set the Position along wall to Offset/Center. 

Set the Automatic offset to 6″. 

12. 

 

Place the opening in the wall between the 

kitchen and the dining room. 

 

13. 

 
 

Select the Work tab to view the openings. 

 

Select the Model tab. 
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14. 

 

 

Place a rectangular opening between the kitchen and the 

family room. 

 

 

This is our floor plan so far. 

 

 

 
 

 

 

 
 

The view is set to Low Detail and rotated 90 

degrees.  

 

15. Save the file as ex3-6.dwg.  
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Exercise 3-7: 

Adding Doors 
 

Drawing Name: ex3-6.dwg 

Estimated Time: 20 minutes 

 

This exercise reinforces the following skills: 

 

� Adding Doors 

 

 

1. 
  

     

Open ex3-6.dwg. 

 

 

 

 

We will add an entry door on the wall indicated. 

 

Remember the exterior walls reside on an external 

reference. 

 

 
 

Select the Exterior Walls. 

Right click and select Edit Xref in-place. 

 

Press OK. 

 

 

Enable Automatically select all nested objects. 

 

Press OK. 

   

2. 

 

Select the Hinged-Double-Exterior door. 
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3. 

 
 

Expand the Dimensions section. 

Set the Standard size to 4′-0″ x 6′-8″. 

Set the Swing angle to 0.  
 

Expand the Location section. 

Set the Position along wall to Offset/Center. 

Set the Automatic offset to 6″. 

4. 

 
 

Place the door so it is centered in the wall. 

5. 

 

 

Select the Overhead-Sectional door. 

6. 

 
 

Expand the Dimensions section. 

Set the Standard size to 8′-0″ x 7′-0″. 

Set the Swing angle to 0. 

7. 

 
 

Set the Position along wall to 

Offset/Center. 

Set the Automatic offset to 6″. 
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8. 

 

Place the door in the garage wall. 

 

9. 

 

 

Switch to the Work tab to view the garage door and front 

entry door. 

 

Switch back to the Model tab. 

10. Next we add a sliding door to the 

family room wall indicated. 

11. Select a Sliding Door –Double Full Lite to add to the 

family room.   

 

12. 

 

 

Set the Standard Size to 8′-0″ x 7′-0″.   

Set the Opening percent to 0.   
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Expand the Location section. 

Set the Position along wall to Offset/ 

Center. 

Set the Automatic offset to 4′-0″. 

13. 

 

Place the sliding door. 

 

14. Save the changes back to the external 

reference. 

   

15. 

 

Press OK. 

   

16. 

 

If your doors don’t look proper, use the 

Display Manager to modify the appearance. 

   

17. 

 

Go to Format→Display Manager. 
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18. 

 

Expand the Configurations folder. 

 

Locate the Plan configuration under Medium Detail. 

 

Note that this configuration is in bold because it is the 

current active configuration. 

19. Place a check mark for Doors 

and Door/Window Assembly to 

set them visible in all views. 

 Press Apply and OK.  

 

 

 

20. Select the Work tab to view your model. 
 

21. Save the file as ex3-7.dwg.   
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Exercise 3-8: 

Add Window Assemblies 
 

Drawing Name: Lesson 3-7.dwg 

Estimated Time: 30 minutes 

 

This exercise reinforces the following skills: 

 

� Add Windows 

 

 

1.      Open ex3-7.dwg.
 

 

Select the Model tab. 

 

2. 

 
 

Select an exterior wall. 

Right click and select Edit Xref In-place. 

 

Press OK. 

3. 

 
 

Select the Windows tab of the Tool Palette. 

Select the Casement-Double window. 

4. Expand the Dimensions section. 

Set the size to 2′-10″ x 3′-0″.   

 

 
 

5. Expand the Location section. 

Set the Position along wall to 

Offset/Center. 

Set the Offset to 4′-0″.   

Set the Head height to 4′-8″. 
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6. 

 
 

Select the wall shown and the 

endpoint indicated. 

 

The endpoint is where the offset 

is calculated from. 

7. Select the Casement-Double window again. 

 

8. 

 
 

Place the window on the vertical master bedroom 

wall. 

 

 
 

Remember – if you don’t like the position of any of the 

Windows, you can reposition them. Just select the window, 

right click, and select ‘Reposition Along Wall.’ 
 

 

9. 

 
 

Select the Casement: Single Casement window. 

10. Expand the Dimensions section. 

Set the size to 2′-0″ x 3′-0″.   
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Expand the Location section. 

Set the Position along wall to Offset/ 

Center. 

Set the Offset to 3′-1″.   

11. 

 

Place the window in the master bath wall. 

 

12. Place a 2′-10″ x 3′-0″ Double Casement window in 

Bedroom #1 using a 4′-8″ offset. 
 

 

13. 

 

 

Place a 2′-10″ x 3′-0″ Double Casement window in 

Bedroom #1 using a 4′-8″ offset on the left vertical 

wall. 
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14. 

 
 

Place a 2′-10″ x 3′-0″ Double Casement 

window in Bedroom #2 using a 6′-8″ offset 

on the left vertical wall. 
 

 

 

A small edit field will appear when you 

select the wall to place a window that allows 

you to change the size of offset on the fly. 

15. 

 

Locate the Picture- Arched to place in the left dining room 

wall. 

 

16. 

 

 

Expand the Dimensions section. 

Set the size to 2′-10″ x 4′-10″ Rise 5″.   

17. 

 

 

Expand the Location section. 

Set the Position along wall to 

Offset/Center. 

Set the Offset to 8′-0″.   

18. 

 

 

Place the window. 
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19. 

 
 

Add a 2′-0″ x 3′-0″ Casement: Single window using 

a 9′-2″ offset to the kitchen. 

 

 

 

 
 

Set the Head height to 6′8″.   

 

This will ensure that any cabinetry in the 

kitchen does not interfere with the 

window. 

 

20. 

 
 

Place an 3′-0″ x 4′ 6″ Rise 5″ Arched 

Picture window with an offset of 0″ on each 

side of the entry door in the right living room 

wall. 

21. 
 

Select the Save Edits tool. 

Press OK to save the modifications to your drawing. 
 

 If Wall Defect symbols appear, try reversing the direction of the wall or using the 

Wall Cleanup tools.  That should eliminate any errors. 

 

22. 

  
 

Your floor plan 

should look similar 

to the one shown 

here. 

 

Save as ex3-8.dwg. 
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Exercise 3-9: 

Adding a Fireplace 
 

Drawing Name: ex3-8.dwg 

Estimated Time: 30 minutes 

 

This exercise reinforces the following skills: 

 

� Using the Design Center 

� Adding Openings 

 

In this exercise, we add a fireplace to the family room.  You can download the fireplace 

from the publisher’s website or use the fireplace available from the Design Center. 

 

 

1.      Open ex3-8.dwg. 

 

Select the Model tab. 

 

2. 
 

 

Select the Design Center tool or type ADC on the command line. 

3. 

 

Select the DC Online tab. 

 

 

 Note:  In order to access DC Online, you must have an active internet connection.  

If you do not have an active connection, you can download the file from the 

publisher’s website and come back to this exercise. 

 

4. 

 

In the Standard Parts section, browse to Fireplaces 

under 3D Architectural/House Design. 
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5. 

 
 

There is a 3D model with a Hearth. 

6. 

 

Hover the mouse over the file icon.  An eyedropper will appear.  

This means the content is idrop-enabled.  Simply hold down your 

left mouse button to fill the eyedropper, then keep the left mouse 

button down, move the mouse into the graphics window and 

release the left mouse button to drag and drop the symbol into the 

drawing file. 

 

7. 

 
 

Place the fireplace into the family room wall. 

8. 

 

Use the 3D Orbit tool to inspect how the fireplace appears. 

 

Go back to a plan view. 

 

9. 

 
 

Go to the Walls Tool Palette. 

 

Select the Brick-4 Brick-4 wall style. 

10. 

 

Draw a wall 3′ 4″ in the vertical direction and 

4′ 8″ in the horizontal direction to enclose the 

hearth. 
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11. 

 
 

Switch to a NE Isometric view to inspect the chimney. 

12. 

 
 

We need to make the chimney taller. 

 

Select the walls for the chimney that were just placed. 

 

Right click and select Properties. 

13. 

 
 

Under Dimensions: 

 

Set the Base Height to 16′. 

14. 

 
 

The chimney now looks better. 

 

Switch back to a plan view. 

15. 

 
 

Place a small section of wall to enclose the chimney. 

16. Select the wall for the chimney that was just placed. 

 

Right click and select Properties. 
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17. 

 
 

Under Location: 

 

Set the Elevation to 8′. 

18. 

 
 

Use 3D Orbit to inspect your work so far. 

19. 

 
 

If you switch to a 3D hidden visual style, you see that we 

need an opening in our fireplace. 

 

Switch back to a plan view. 

20. 

 

Select the wall where the fireplace is placed. 

 

Right click and select Edit Xref in-place. 
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21. 

 
 

Press OK. 

22. 

 
 

Select the Opening tool from the Design Palette. 

23. 

 
 

Change the Height to 2′ 10″. 

24. 

 

Place the opening in the wall. 
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25. 

 

Use 3D Orbit and Zoom to inspect the opening in the 

fireplace. 

   

26. 

 

Use the Add tool to add the chimney 

and fireplace to the external 

reference. 

   

27. 

 

Select the Save icon to save the 

change to the external reference. 

   

28. 

 

Press OK. 

   

29. 

 

Your finished fireplace and chimney should look 

similar to this. 

 

Save the file as ex3-9.dwg. 

 

Close all open drawings. 

You can do this by typing CLOSEALL on the 

command line. 
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